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Course

* Applied Topics in Management Engineering
» 22059-ENG - Applied Topics in Management Engineering (6 credits)
 Teachers

Prof. Giuseppe Pellegrini
Prof. Renato Redondi, renato.redondi@unibq.it

* Period from 24th February 2020 to the 15t June 2020

» Schedule: Monday 8:30:10:30
Wednesday 9:00-11:00

 Classroom A003 (Building A, ground floor)
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Organization

* Reception times: Monday 10:30-13:30, by appointment via e-mail
° e-mail
— renato.redondi@unibg.it

* Online Material site: e-learning Moodle
— https://elearningl5.unibg.it/course/view.php?id=1515
— download and print before each lesson

— Download the files (e.g. Excel, Matlab, Access) to be employed during
lectures

— The online notes cover "the core" of the topics.

— It is essential to attend the laboratory lectures
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Reference books and references

Major references

* Lecture notes, case studies and other material distributed by the course teachers

Bibliography

* Alexander, M., Kusleika, R., & Walkenbach, J. (2018). Excel 2019 Bible. John Wiley &
Sons.

* Alexander, M. & Kusleika, R. (2018). Access 2019 Bible. John Wiley & Sons.
* Matlab online support materials
* On-line tutorials and other materials referenced to in each lecture
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Examination

« There are no intermediate tests
» The final exam consists in the preparation of two reports and the related discussion:
 the first regards the topic of statistical quality control, to be agreed with Prof. Pellegrini

» the second regards economics and company organization issues, to be agreed with Prof.
Redondi

« To be admitted to the examination, students must register online
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The course - objective

The student will acquire the following practical skills:

1- the use of excel for solving problems related to statistical quality control and the

economy and business organization;

2- the use of Access to solve problems related to database management, the analysis of

products and business processes; and

3) the use of Matlab with simulation, sampling and quality control applications.
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The course - content

The course consists of the following subjects:

1- Introduction to the use of Excel, Access and Matlab. Solving typical problems such as data
conversion between different formats and the generation of random numbers for simulation

purposes.
2- Practical applications in the field of statistical quality control (sampling, quality control charts, etc.);

3- Practical applications in the field of business economics and organization, management

control and information management (investment analysis, clustering and database management)
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EXCEL

What is MS Excel?

* |tis a spreadsheet program.

* |[tis used to enter, edit, format, sort numeric data and perform mathematical
computations.

Book1 - Excel
File Home Insert Page Layout Formulas Data Review View Help P Search 1% Share U Comments
@22 B sUEE N0 g & & BH | =
G? &M Refr::h E] % G Em.j,\ 2 Filter = TLe)xlto 5 7 V%?H Forecast | Outline
Deta v 2 Al B bocks _ Geagrapy [Fi{Ba 0 g Advancad | Cohimns =57 BB [ et s
Get & Transform Data| Queries & Conn Data Types Sort & Filter Data Tools Forecast t ~
c10 ¥ f =COUNTIFS(C2:C9,2,A2:A9,"France") v
A B & D E I G H | J K L [\
1 Country City Number
2 France Paris 1
3 France Strasbour| 2
4 Germany Frankfurt 3
5 Germany Berling 2
6 Spain Madrid 1
7 Spain Barcelona 3
8 |ltaly Rome 2 @
9 ltaly Milan 1
10 4 4 1
"
12
13
14 =
Sheet1 <« 3
Ready H - [ ] + 100%

Fig.1: The Excel interface
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AGENDA

Lecture |

CHARTS

FORMULAS
 Relative and Absolute Cell References

FUNCTIONS
WHAT-IF ANALYSIS
SAVINGS
FURTHER MATERIAL
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CHARTS

* Creating a chart is quick and easy.
* You can choose between several types of charts such as:

* Line charts
 Barcharts

* Pie charts

e« Column charts

and so on

 Showing data in a chart can help you evaluate your data and make comparisons
between different values.
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L
CHARTS

How to make a chart

Select the cells you want to chart, including the column titles and row labels. X
From the Insert tab, click the desired Chart command.
Choose the desired chart type from the drop-down menu.
The selected chart will be inserted in the worksheet.

1.
2.
3.
4.

HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW
— r— o = = - . = . ke,
(_T. L7 - & i Store I f;) AME ar=
PivotTable Ffsccmrr':sn:‘led Table F‘ictu;ec OI'I“I:lE o ﬂ My Apps = H RE{Qmm;ndEd 2-D Column
PivotTables Pictures @+~ ) Charts R — I Fl F
Tables ustrations Apps 1 = M ep
Chari4 il - f'.l 3-D Column
A E C D E F G H A @l I
1 Sales 2014 2015 iy ol Al
2 lteml 58,000.00 55,600.00 .
3 item2 |$4,300.00 $45,300.00 M
4 Item3 $3,400.00 $3,400.00 U
5 Itemd $5,600.00 $3,300.00 i More Colun .
& Item5 $3,400.00 53,200.00
7 ltemt $2,400.00 523,400.00
8 ltem7 53,300.00 $200.00
9 Items  154,500.00 $3,400.00]

Fig.2: The selection of cells
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CHARTS

How to edit chart layout and style

* After inserting a chart, from the Design tab, you may change the way your data is
displayed.

* You may add chart elements - such as chart titles, legends, and data labels—to
make your chart easier to read:

1 —.:. - = j“J
1. Click the Add Chart Element et - £
command on the Design tab R e | ki
2. Choose the desired element from the b oere » I
drop-down menu. = o S0 4 2
To edit a chart element, (e.g. chart title),
simply double-click the placeholder and = .
begin typing
Fig.3: Inserting a legend
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FORMULAS

How to enter a formula

* |n Excel you can perform mathematical computations using formulas.

* All formulas in Excel must begin with an equals sign (=).

 Formulas may be Simple (a single mathematical operator) or Complex (more than one
mathematical operator).

SUM - i X« fr | =(p2+D3)%0.075

A B C D
- Menu Item Price Quantity Total |
2 ltem 1 $2.29 20| $45.80 |
3 Item 2 $2.29 30/ $68.70 |
4 =(D24D3)*0.075|
5 Total

Fig.4: Inserting a complex fromula
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FORMULAS

Relative and Absolute Cell References X

* Cells references may be:

* Relative: references change when a formula is copied to another cell.
e Absolute: absolute references remain constant when a formula is copied to another cell.

Click and hold the fill handle to drag

. the formula into the cells below
Relative Cell References

A B C D L B C D
1 ‘Mem |price |quantity [fotal |
* By default, all cell 2 [item 1 $2.00 s 2 item1 $2.00 al  $8.00
references are relative. 3 item 2 400 2 3 |ttem 2 A 2 5800
4 Iltem3 $6.00 1 4 Item3 $6.00 1 $6.00
5 ltem4d $3.00 > Item4 | 53.00_ ! $0.00
* These are convenient to use 5 items | $200 > ttems [ o200 5i-86"CH
7 ltemb6 $8.00 3 7 ltem6 $8.00 3 $24.00
when you want to repeat 8 item7 $2.00 3 8 [item 7 $2.00 3
: 9 Item8 $1.00 6 9 |ltem8 $1.00 6
the same calculation across Y 500 . e o~ >
multiple rows or columns. 11 item10 |  $7.00 5 11 item 10 $7.00 5
12 Total 12 Total
Fig.5: Dragging the formula Fig.6: Calculation of the value in each cell

UNIVERSITA t 14
DEGLI STUDI
DI BERGAMO




I
FORMULAS

Absolute Cell References

 |tis represented by the dollar sign ($).

 $A$1 (F4): The column and the row do not change when copied
 A$1: The row does not change when copied
* $A1: The column does not change when copied

A B C D :
1 Sales Tax ! 7.50!_I
2
3tem1 |  s2.000 al  ssoo|=(e3*c3)*sesy |
4 Item2 $4.00 2 $8.00
5 |[Item 3 $6.00 1 $6.00 \
e T w00 Click and hold the fill handle to drag
8 Iltem6 $5.00 3|  $24.00 the formula into the cells below
9 item?7 $2.00 3 $6.00
10 |Item 8 $1.00 6 $6.00
11 Item9 $9.00 2 $18.00
12 Item 10 $7.00 5 $35.00
13 Total

Fig.7: Absolute reference

UNIVERSITA { G
DEGLI STUDI
DI BERGAMO




FUNCTIONS

How to enter a function

A function is a predefined formula that performs calculations using specific values
in a particular order.

In Excel you can use functions in order to quickly find the sum (SUM), average
(AVERAGE), count (COUNT), minimum value (MIN) and maximum value (MAX) for a
range of cells.

Each function has one or more arguments. Multiple arguments are divided by a
comma.

Some of the most common functions used are: UM i X  fr| =sumarazcrcae)
- B C D E F

« SUM (A1,C3) 1 34 ‘ ss“ | 6

* AVERAGE (A1:A3) S — =

« COUNT (argument) 4 ' |

*  MIN/MAX (argument) 8 [sumiasza,cocae)

Fig.7: Example of multiple arguments
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WHAT-IF ANALYSIS
GOAL SEEK (RICERCA OBIETTIVO)

* You may use “Goal seek” to find the input value that produces a known result.

1 E Scenario Manager...
. BN E
Click on Data Tab What_lf[},;o Goal Seck... N\
Analysis» S Data Table...

Forecast
Fig.8: Goal seek on the Data tab

 Forexample, use “Goal seek” to find the quantity that you must sell of the fourth product in order to have
20000 euro of revenue.

A B C D Ricerca obiettivo ? X A : C D

1 | Product Price  Quantity 1 | Product Price  Quantity

2 1 2,00€ 1117 2.234 € Imposta la cella: $D$7 * 2 1 2,00€ 1117 2.234 €
3 2 2,00€ 2002 4,004 € Al valore: 20000 3 2 2,00€ 2002 4.004 €
4 3 100€ 1478 1478 € Cambiando la cella: | $C$5| 4 4 3 100€ 1478 1.478 €
5 4 5,00 € 1765 8.825€ 5 4 500€ 2457 12.284 €
6 oK Annulla (3]

7 REVENUE 16.541€ 7 REVENUE 20.000 €

Fig.9: «Goal Seek» example
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WHAT-IF ANALYSIS

DATA TABLE (TABELLA DATI)

* You may use “Data table” to create a data table to try out different values for formulas.

* For example, use “Data Table” to calculate the total profit if you sell at the lower price different % of products.

1
2
3
4
5
6
7
8
9
10
11
12
13
14
15
16
17
18
19
20

QD

A B

X

Step 1: Selecting the range in which you have to calculate the total profit with different %

C D

Total number of
products
1000

Lower price
Highest price

% sold for the lower
price
20%

Number of products
200
800

Total Profit

20%
30%
40%
50%
60%
70%
80%
90%
100%

2.520€

UNIVERSITA
DEGLI STUDI
DI BERGAMO

Price

0,60 €
3,00€

2.520€

Step 2: Click on Data Tab:

]
What-If Fo
Analysis~ S

Forecast

Goal Seek...

Data Table...

Scenario Manager...

s

Step 3: Select the cell which the % refer to

Tabella dati

Cella di input per riga:

Cella di input per colonna:

?

$C$3

OK

Annulla

X

|»

|

Fig.10: «Data Table» example

A

B

Total number of
products

1000

Lower price
Highest price

20%
30%
40%
50%
60%
70%
80%
90%
100%

C D E
% sold for the lower
price
20%

Price
0,60€
3,00€

Number of products
200
800
Total Profit 2.520€
2.520€
2520
2280
2040
1800
1560
1320
1080
840
600



SAVING

How to save a workbook

1. Select the Save command on the Quick Access Toolbar.
2. If you're saving the file for the first time, the Save As pane will appear in
Backstage view.

3. Choose where to save the file and give it a file name.
4. Click Save. The workbook will be saved.
5. Now, you can click the Save command again to save your changes as you

modify the workbook.

] =
HOME  INSERT

X Euphemia ~ |10
e~ B I U- A

\0 i . ﬁ’ . A .

Clipboard T~ Font

Fig.11: Selecting the save command
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FURTHER MATERIAL

To review and deepen the topics of this lecture

1. https://www.youtube.com/watch?v=30110ILgYDo&list=PLIKpQrBMEGxLYoubj
0OgowzcCCdOivOVLY&index=10&t=0s

2. https://www.youtube.com/watch?v=0SNuRasYI60&list=PLIKpOrBMEGxLYoubj
OgowzcCCdOivQVLY&index=5

3. https://www.youtube.com/watch?v=JI0Qk63z2ZY&list=PLIKpQrBMEGxLYoubjO
qowzcCCdOivOQVLY&index=18

4. https://www.youtube.com/watch?v=0hnkuBVTcg8

5. https://www.youtube.com/watch?v=y7S9ecg1wdQ

6. Alexander, M., Kusleika, R., & Walkenbach, J. (2018). Excel 2019 Bible. John
Wiley & Sons.
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